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2 — Flash*Freeze Technology and Low Power
Modes

Flash*Freeze Technology and Low Power Modes

Microsemi IGLOO,® IGLOO nano, IGLOO PLUS, ProASIC®3L, and Radiation-Tolerant (RT) ProASIC3
FPGAs with Flash*Freeze technology are designed to meet the most demanding power and area
challenges of today’s portable electronics products with a reprogrammable, small-footprint, full-featured
flash FPGA. These devices offer lower power consumption in static and dynamic modes, utilizing the

unique Flash*Freeze technology, than any other FPGA or CPLD.

IGLOO, IGLOO nano, IGLOO PLUS, ProASIC3L, and RT ProASIC3 devices offer various power-saving
modes that enable every system to utilize modes that achieve the lowest total system power. Low Power
Active capability (static idle) allows for ultra-low power consumption while the device is operational in the

system by maintaining SRAM, registers, 1/0s, and logic functions.

Flash*Freeze technology provides an ultra-low power static mode (Flash*Freeze mode) that retains all
SRAM and register information with rapid recovery to Active (operating) mode. IGLOO nano and IGLOO
PLUS devices have an additional feature when operating in Flash*Freeze mode, allowing them to retain
1/0 states as well as SRAM and register states. This mechanism enables the user to quickly (within 1 ps)
enter and exit Flash*Freeze mode by activating the Flash*Freeze (FF) pin while all power supplies are
kept in their original states. In addition, 1/Os and clocks connected to the FPGA can still be toggled
without impact on device power consumption. While in Flash*Freeze mode, the device retains all core
register states and SRAM information. This mode can be configured so that no power is consumed by
the 1/0 banks, clocks, JTAG pins, or PLLs; and the IGLOO and IGLOO PLUS devices consume as little
as 5 W, while IGLOO nano devices consume as little as 2 yW. Microsemi offers a state management IP

core to aid users in gating clocks and managing data before entering Flash*Freeze mode.

This document will guide users in selecting the best low power mode for their applications, and

introduces Microsemi's Flash*Freeze management IP core.
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Global Resources in Low Power Flash Devices

[}
|
|
[}
2 2 | 2 2
// // [} // //
|
[}
[}
[}
|
[}
[}
Chip (main) Global
Network

1 2,
L

2/ ‘ . 1 . . 7 14

7 |
] /

Global Drivers Global Drivers
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Clock Conditioning Circuits in Low Power Flash Devices and Mixed Signal FPGAs

Core Logic Clock Source

Core logic refers to internal routed nets. Internal routed signals access the CCC via the FPGA Core
Fabric. Similar to the External I/O option, whenever the clock source comes internally from the core itself,
the routed signal is instantiated with a PLLINT macro before connecting to the CCC clock input (see

Figure 4-12 for an example illustration of the connections, shown in red).

To Core
A AA
Gmn*X ll>
Multiplexer by | o cLKDLY
Tree
N\ Macro
Gmn*Bg L%D To Global (or Local)
o Global (or Loca
O Routing Network
[OuxwByVz* X ll>
Gmn* = Global Input Pin
Routed Clock I0uxwBYyVz = Regular I/0 Pin
A (from FPGA Core)
Gmn* X 4
PLLINT From Internal

Signals

Figure 4-12 « lllustration of Core Logic Usage

For Fusion devices, the input reference clock can also be from the embedded RC oscillator and crystal
oscillator. In this case, the CCC configuration is the same as the hardwired 1/O clock source, and users

are required to instantiate the RC oscillator or crystal oscillator macro and
reference clock of the CCC block.

connect its output to the input

92
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When SmartGen is used to define the configuration that will be shifted in via the serial interface,
SmartGen prints out the values of the 81 configuration bits. For ease of use, several configuration bits
are automatically inferred by SmartGen when the dynamic PLL core is generated; however, <71:73>
(STATASEL, STATBSEL, STATCSEL) and <77:79> (DYNASEL, DYNBSEL, DYNCSEL) depend on the
input clock source of the corresponding CCC. Users must first run Layout in Designer to determine the
exact setting for these ports. After Layout is complete, generate the "CCC_Configuration” report by
choosing Tools > Reports > CCC_Configuration in the Designer software. Refer to "PLL Configuration
Bits Description" on page 106 for descriptions of the PLL configuration bits. For simulation purposes, bits
<71:73> and <78:80> are "don't care." Therefore, it is strongly suggested that SmartGen be used to
generate the correct configuration bit settings for the dynamic PLL core.

After setting all the required parameters, users can generate one or more PLL configurations with HDL or
EDIF descriptions by clicking the Generate button. SmartGen gives the option of saving session results
and messages in a log file:

Macro Parameters

Name : dyn_pll_hardio
Family : ProASIC3E
Output Format > VERILOG

Type : Dynamic CCC
Input Freq(MHz) - 30.000

CLKA Source : Hardwired 1/0
Feedback Delay Value Index o1

Feedback Mux Select o1

XDLY Mux Select : No

Primary Freq(MHz) : 33.000
Primary PhaseShift : 0

Primary Delay Value Index o1

Primary Mux Select : 4

Secondaryl Freq(MHz) : 40.000

Use GLB : YES

Use YB : NO

GLB Delay Value Index o1

YB Delay Value Index o1

Secondaryl PhaseShift : 0

Secondaryl Mux Select : 0

Secondaryl Input Freq(MHz) : 40.000

CLKB Source : Hardwired 170
Secondary2 Freq(MHz) : 50.000

Use GLC : YES

Use YC : NO

GLC Delay Value Index o1

YC Delay Value Index o1

Secondary2 PhaseShift : 0

Secondary2 Mux Select : 0

Secondary2 Input Freq(MHz) : 50.000

CLKC Source : Hardwired 1/0

Configuration Bits:

FINDIV[6:0] 0000101
FBDIV[6:0] 0100000
OADIV[4:0] 00100
OBDIV[4:0] 00000
0CDIV[4:0] 00000
OAMUX[2:0] 100
OBMUX[2:0] 000
OCMUX[2:0] 000
FBSEL[1:0] 01
FBDLY[4:0] 00000
XDLYSEL 0
DLYGLA[4:0] 00000
DLYGLB[4:0] 00000
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DYNCCC Core(.CLKA(CLKA), -EXTFB(GND), .POWERDOWN(POWERDOWN), .GLA(GLA), -LOCK(LOCK),
.CLKB(CLKB), .GLB(GLB), .YB(), -CLKC(CLKC), .GLC(GLC), .YC(Q). -SDIN(SDIN),
.SCLK(SCLK), .SSHIFT(SSHIFT), .SUPDATE(SUPDATE), .MODE(MODE), .SDOUT(SDOUT),
_OADIVO(GND), .OADIVL(GND), -OADIV2(VCC), .OADIV3(GND), .OADIVA(GND), .OAMUXO(GND),
.OAMUX1(GND), .OAMUX2(VCC), .DLYGLAO(GND), .DLYGLAL(GND), .DLYGLA2(GND),
_.DLYGLA3(GND), .DLYGLA4(GND), -OBDIVO(GND), -OBDIV1(GND), -OBDIV2(GND),
_OBDIV3(GND), .OBDIV4(GND), -OBMUXO(GND), .OBMUX1(GND), .OBMUX2(GND), .DLYYBO(GND),
.DLYYB1(GND), .DLYYB2(GND), .DLYYB3(GND), .DLYYB4(GND), .DLYGLBO(GND),
.DLYGLB1(GND), .DLYGLB2(GND), .DLYGLB3(GND), .DLYGLB4(GND), .OCDIVO(GND),
.OCDIV1(GND), .OCDIV2(GND), .OCDIV3(GND), .OCDIV4(GND), .OCMUXO(GND), .OCMUX1(GND),
.OCMUX2(GND), .DLYYCO(GND), .DLYYCL(GND), .DLYYC2(GND), .DLYYC3(GND), .DLYYC4(GND),
.DLYGLCO(GND), .DLYGLC1(GND), -DLYGLC2(GND), .DLYGLC3(GND), .DLYGLC4(GND),
_FINDIVO(VCC), .FINDIV1(GND), .FINDIV2(VCC), .FINDIV3(GND), .FINDIV4(GND),
_.FINDIV5(GND), -FINDIV6(GND), .FBDIVO(GND), .FBDIVL(GND), .FBDIV2(GND),
_FBDIV3(GND), .FBDIV4(GND), -FBDIV5(VCC), .FBDIV6(GND), .FBDLYO(GND), .FBDLY1(GND),
_FBDLY2(GND), .FBDLY3(GND), .FBDLY4(GND), .FBSELO(VCC), .FBSEL1(GND),
_XDLYSEL(GND), .VCOSELO(GND), .VCOSEL1(GND), .-VCOSEL2(VCC));

defparam Core.VCOFREQUENCY = 165.000;

endmodule

Delayed Clock Configuration

The CLKDLY macro can be generated with the desired delay and input clock source (Hardwired 1/O,
External I/0, or Core Logic), as in Figure 4-28.

Delayed Clock : Create Core E|

Global output delay:

Input clock source: |Hardwired [Ein}

[
Help Close

Figure 4-28 « Delayed Clock Configuration Dialog Box

After setting all the required parameters, users can generate one or more PLL configurations with HDL or
EDIF descriptions by clicking the Generate button. SmartGen gives the option of saving session results
and messages in a log file:

Macro Parameters

Name : delay_macro
Family : ProASIC3
Output Format : Verilog

Type : Delayed Clock
Delay Index 12

CLKA Source : Hardwired 1/0

Total Clock Delay = 0.935 ns.
The resultant CLKDLY macro Verilog netlist is as follows:
module delay_macro(GL,CLK);

output GL;
input CLK;
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Date Changes Page
v1.2 The following changes were made to the family descriptions in Figure 4-1 « Overview 77
(June 2008) of the CCCs Offered in Fusion, IGLOO, and ProASIC3:

* ProASIC3L was updated to include 1.5 V.
» The number of PLLs for ProASIC3E was changed from five to six.

v1.1 Table 4-1 - Flash-Based FPGAs and the associated text were updated to include the 79
(March 2008) IGLOO PLUS family. The "IGLOO Terminology" section and "ProASIC3 Terminology"
section are new.

The "Global Input Selections" section was updated to include 15 k gate devices as 87
supported I/O types for globals, for CCC only.

Table 4-5 « Number of CCCs by Device Size and Package was revised to include 94
ProASIC3L, IGLOO PLUS, A3P015, AGL015, AGLP030, AGLP060, and AGLP125.

The "IGLOO and ProASIC3 CCC Locations" section was revised to include 15 k gate 97
devices in the exception statements, as they do not contain PLLs.

v1.0 Information about unlocking the PLL was removed from the "Dynamic PLL 103
(January 2008) Configuration" section.

In the "Dynamic PLL Configuration" section, information was added about running 116
Layout and determining the exact setting of the ports.

In Table 4-8 « Configuration Bit Descriptions for the CCC Blocks, the following bits 106
were updated to delete "transport to the user" and reference the footnote at the bottom
of the table: 79 to 71.
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SRAM and FIFO Memories in Microsemi's Low Power Flash Devices

Write Data Read Data
WD > > RD
Write Add
WADDR 2 eS8 ReadAddress 1 AbDR
RAM512X18
Write Enable Read Enable
WEN —> —— <«—REN
Write CLK
WCLK—> ? | Read CLK, pcik
Reset

Note: For timing diagrams of the RAM signals, refer to the appropriate family datasheet.
Figure 6-5 « 512X18 Two-Port RAM Block Diagram

Signal Descriptions for RAM512X18
RAMS512X18 has slightly different behavior from RAM4K9, as it has dedicated read and write ports.

WW and RW
These signals enable the RAM to be configured in one of the two allowable aspect ratios (Table 6-5).

Table 6-5 « Aspect Ratio Settings for WW[1:0]

WWI[1:0] RWI[1:0] DxW
01 01 512x9
10 10 256x%18
00, 11 00, 11 Reserved
WD and RD

These are the input and output data signals, and they are 18 bits wide. When a 512x9 aspect ratio is
used for write, WD[17:9] are unused and must be grounded. If this aspect ratio is used for read, RD[17:9]
are undefined.

WADDR and RADDR

These are read and write addresses, and they are nine bits wide. When the 256x18 aspect ratio is used
for write or read, WADDR[8] and RADDR([8] are unused and must be grounded.

WCLK and RCLK

These signals are the write and read clocks, respectively. They can be clocked on the rising or falling
edge of WCLK and RCLK.

WEN and REN

These signals are the write and read enables, respectively. They are both active-low by default. These
signals can be configured as active-high.

RESET

This active-low signal resets the control logic, forces the output hold state registers to zero, disables
reads and writes from the SRAM block, and clears the data hold registers when asserted. It does not
reset the contents of the memory array.

While the RESET signal is active, read and write operations are disabled. As with any asynchronous
reset signal, care must be taken not to assert it too close to the edges of active read and write clocks.
PIPE

This signal is used to specify pipelined read on the output. A LOW on PIPE indicates a nonpipelined
read, and the data appears on the output in the same clock cycle. A HIGH indicates a pipelined read, and
data appears on the output in the next clock cycle.
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SRAM and FIFO Memories in Microsemi's Low Power Flash Devices

Example of RAM Initialization

This section of the document presents a sample design in which a 4x4 RAM block is being initialized
through the JTAG port. A test feature has been implemented in the design to read back the contents of
the RAM after initialization to verify the procedure.

The interface block of this example performs two major functions: initialization of the RAM block and
running a test procedure to read back the contents. The clock output of the interface is either the write
clock (for initialization) or the read clock (for reading back the contents). The Verilog code for the
interface block is included in the "Sample Verilog Code" section on page 167.

For simulation purposes, users can declare the input ports of the UJTAG macro for easier assignment in
the testbench. However, the UJTAG input ports should not be declared on the top level during synthesis.
If the input ports of the UJTAG are declared during synthesis, the synthesis tool will instantiate input
buffers on these ports. The input buffers on the ports will cause Compile to fail in Designer.

Figure 6-10 shows the simulation results for the initialization step of the example design.

The CLK_OUT signal, which is the clock output of the interface block, is the inverted DR_UPDATE output
of the UJTAG macro. It is clear that it gives sufficient time (while the TAP Controller is in the Data
Register Update state) for the write address and data to become stable before loading them into the RAM
block.

Figure 6-11 presents the test procedure of the example. The data read back from the memory block
matches the written data, thus verifying the design functionality.

== wave - default

Flle Edit Cursor Zoom Bookmark Format ‘Window

HEBE LK o  QQOQ@fr | Ef | ELEIEE

(0000 0007 jooio  jooid

Figure 6-10 « Simulation of Initialization Step

=i wave - default

File Edit Cursor Zoom  Bookmark  Format  window

BEE +BBR L X 1o RQQ@fK F EIEIEEH
' 0000 {0000 [ ¥o0T [ Y0070 [ Y0071

ik ut |1

testbench/top_init_0Vinit_block/enable | St0

Figure 6-11 « Simulation of the Test Procedure of the Example
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Selectable Skew between Output Buffer Enable and Disable Times

Low power flash devices have a configurable skew block in the output buffer circuitry that can be enabled
to delay output buffer assertion without affecting deassertion time. Since this skew block is only available
for the OE signal, the feature can be used in tristate and bidirectional buffers. A typical 1.2 ns delay is
added to the OE signal to prevent potential bus contention. Refer to the appropriate family datasheet for
detailed timing diagrams and descriptions.

The skew feature is available for all I/O standards.

This feature can be implemented by using a PDC command (Table 7-5 on page 179) or by selecting a
check box in the 1/0 Attribute Editor in Designer. The check box is cleared by default.

The configurable skew block is used to delay output buffer assertion (enable) without affecting
deassertion (disable) time.

Output Enable [ENABLE (IN)
(from FPGA core)

\i

MUX ENABLE (OUT)

Y

Skew Circuit

I/O Output
Buffers

Skew Select

Figure 7-13 « Block Diagram of Output Enable Path

ENABLE (IN)

ENABLE (OUT)

— 5-4— - -
Less than Less than
0.1ns 0.1 ns

Figure 7-14 « Timing Diagram (option 1: bypasses skew circuit)
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Table 7-19 shows some high-level interfacing examples using low power flash devices.

Table 7-19 « High-Level Interface Examples

Clock I/10

Interface Type Frequency Type Signals In Signals Out Data I/O
GM Src Sync 125 MHz LVTTL 8 8 125 Mbps
TBI Src Sync 125 MHz LVTTL 10 10 125 Mbps
XSBI Src Sync 644 MHz LVDS 16 16 644 Mbps
XGMI Src Sync DDR 156 MHz HSTL1 32 32 312 Mbps
FlexBus 3 Sys Sync 104 MHz LVTTL < 32 < 32 <104
Pos-PHY3/SPI-3 Sys Sync 104 LVTTL 8, 16, 32 8, 16, 32 <104 Mbps
FlexBus 4/SPI-4.1 Src Sync 200 MHz HSTL1 16,64 16,64 200 Mbps
Pos-PHY4/SPI-4.2 | Src Sync DDR >311 MHz LVDS 16 16 > 622 Mbps
SFI-4.1 Src Sync 622 MHz LVDS 16 16 622 Mbps
CsIX L1 Sys Sync <250 MHz HSTL1| 32,64,96,128 | 32,64,96,128 | <250 Mbps
Hyper Transport Sys Sync DDR <800 MHz LVDS 2,4,8,16 2,4,8,16 <1.6 Gbps
Rapid I/O Parallel | Sys Sync DDR | 250 MHz -1 GHz | LVDS 8,16 8,16 <2 Gbps
Star Fabric CDR LvDS 4 4 622 Mbps

Note: Sys Sync = System Synchronous Clocking, Src Sync = Source Synchronous Clocking, and CDR = Clock and
Data Recovery.

Conclusion

IGLOO and ProASIC3 support for multiple I/O standards minimizes board-level components and makes
possible a wide variety of applications. The Microsemi Designer software, integrated with Libero SoC,
presents a clear visual display of /0 assignments, allowing users to verify I/O and board-level design
requirements before programming the device. The IGLOO and ProASIC3 device I/O features and
functionalities ensure board designers can produce low-cost and low power FPGA applications fulfilling
the complexities of contemporary design needs.
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Table 8-7 « Maximum 1/O Frequency for Single-Ended and Differential I/Os in All Banks in
ProASIC3E Devices (maximum drive strength and high slew selected)

Maximum Performance
IGLOOe V2 or V5
Devices, 1.5V DC Core | IGLOOe V2,1.2V DC
Specification ProASIC3E Supply Voltage Core Supply Voltage
LVTTL/LVCMOS 3.3 V 200 MHz 180 MHz TBD
LVCMOS 2.5V 250 MHz 230 MHz TBD
LVCMOS 1.8V 200 MHz 180 MHz TBD
LVCMOS 1.5V 130 MHz 120 MHz TBD
PCI 200 MHz 180 MHz TBD
PCI-X 200 MHz 180 MHz TBD
HSTL-I 300 MHz 275 MHz TBD
HSTL-II 300 MHz 275 MHz TBD
SSTL2-I 300 MHz 275 MHz TBD
SSTL2-11 300 MHz 275 MHz TBD
SSTL3-I 300 MHz 275 MHz TBD
SSTL3-1I 300 MHz 275 MHz TBD
GTL+ 3.3V 300 MHz 275 MHz TBD
GTL+ 25V 300 MHz 275 MHz TBD
GTL3.3V 300 MHz 275 MHz TBD
GTL25V 300 MHz 275 MHz TBD
LVDS 350 MHz 300 MHz TBD
M-LVDS 200 MHz 180 MHz TBD
B LVDS 200 MHz 180 MHz TBD
LVPECL 350 MHz 300 MHz TBD

Revision 4 219



& Microsemi

ProASIC3L FPGA Fabric User’'s Guide

This current draw can occur in the following cases:

* In Active and Static modes:
— Input buffers with pull-up, driven Low
— Input buffers with pull-down, driven High
— Bidirectional buffers with pull-up, driven Low
— Bidirectional buffers with pull-down, driven High
— Output buffers with pull-up, driven Low
— Output buffers with pull-down, driven High
— Tristate buffers with pull-up, driven Low
— Tristate buffers with pull-down, driven High

* In Flash*Freeze mode:
— Input buffers with pull-up, driven Low
— Input buffers with pull-down, driven High
— Bidirectional buffers with pull-up, driven Low
— Bidirectional buffers with pull-down, driven High

Electrostatic Discharge Protection

Low power flash devices are tested per JEDEC Standard JESD22-A114-B.

These devices contain clamp diodes at every 1/O, global, and power pad. Clamp diodes protect all device
pads against damage from ESD as well as from excessive voltage transients.

All IGLOO and ProASIC3 devices are tested to the Human Body Model (HBM) and the Charged Device
Model (CDM).

Each I/0 has two clamp diodes. One diode has its positive (P) side connected to the pad and its negative
(N) side connected to VCCI. The second diode has its P side connected to GND and its N side
connected to the pad. During operation, these diodes are normally biased in the off state, except when
transient voltage is significantly above VCCI or below GND levels.

In 30 k gate devices, the first diode is always off. In other devices, the clamp diode is always on and
cannot be switched off.

By selecting the appropriate 1/0 configuration, the diode is turned on or off. Refer to Table 8-13 for more
information about the 1/0 standards and the clamp diode.

The second diode is always connected to the pad, regardless of the 1/O configuration selected.

Table 8-13 « /0 Hot-Swap and 5 V Input Tolerance Capabilities in IGLOOe and ProASIC3E Devices

Clamp Hot 5V Input Input Output
I/O Assignment Diode Insertion Tolerance Buffer Buffer
3.3 VLVTTL/LVCMOS No Yes Yes' Enabled/Disabled
3.3V PCI, 3.3V PCI-X Yes No Yes' Enabled/Disabled
LVCMOS 2.5V ? No Yes No Enabled/Disabled
LVCMOS 2.5V /5.0 V ? Yes No Yes® Enabled/Disabled
LVCMOS 1.8V No Yes No Enabled/Disabled
LVCMOS 1.5V No Yes No Enabled/Disabled
Voltage-Referenced Input Buffer No Yes No Enabled/Disabled
Differential, LVDS/B-LVDS/M-LVDS/LVPECL No Yes No Enabled/Disabled

Notes:

1. Can be implemented with an external IDT bus switch, resistor divider, or Zener with resistor.
2. Inthe SmartGen Core Reference Guide, select the LVCMOS5 macro for the LVCMOS 2.5V /5.0 V I/O standard

or the LVCMOS25 macro for the LVCMOS 2.5 V I/O standard.
3. Can be implemented with an external resistor and an internal clamp diode.
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1/0 Software Control in Low Power Flash Devices

Automatically Assigning Technologies to I/O Banks

The I/O Bank Assigner (IOBA) tool runs automatically when you run Layout. You can also use this tool
from within the MultiView Navigator (Figure 9-17). The IOBA tool automatically assigns technologies and
VREF pins (if required) to every I/O bank that does not currently have any technologies assigned to it.
This tool is available when at least one I/O bank is unassigned.

To automatically assign technologies to I/O banks, choose I/O Bank Assigner from the Tools menu (or
click the 1/0 Bank Assigner's toolbar button, shown in Figure 9-16).

-
i

Figure 9-16 « I/0 Bank Assigner’'s Toolbar Button

Messages will appear in the Output window informing you when the automatic /O bank assignment
begins and ends. If the assignment is successful, the message "I/O Bank Assigner completed
successfully" appears in the Output window, as shown in Figure 9-17.
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Figure 9-17 « I/0 Bank Assigner Displays Messages in Output Window
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DDR Input Register

INBUF_SSTL2_Ippr Reg

PAD PAD Y D oR ar
CLK P QF QF
CLR

CLR |

Figure 10-5 « DDR Input Register (SSTL2 Class I)

The corresponding structural representations, as generated by SmartGen, are shown below:

Verilog
module DDR_InBuf_SSTL2_ I(PAD,CLR,CLK,QR,QF);

input PAD, CLR, CLK;
output QR, QF;

wire Y;

INBUF_SSTL2_ 1 INBUF_SSTL2_1_0_inst(.PAD(PAD),.Y(Y));
DDR_REG DDR_REG_O_inst(.D(Y),.CLK(CLK), .CLR(CLR), -QR(QR), .QF(QF)):

endmodule

VHDL

library ieee;

use ieee.std_logic_1164.all;

--The correct library will be inserted automatically by SmartGen
library proasic3; use proasic3.all;

--library fusion; use fusion.all;

--library igloo; use igloo.all;

entity DDR_InBuf _SSTL2_ 1 is
port(PAD, CLR, CLK : in std_logic; OQR, QF : out std_logic) ;
end DDR_InBuf_SSTL2_1I;

architecture DEF_ARCH of DDR_InBuf SSTL2_ 1 is

component INBUF_SSTL2_|I
port(PAD : in std_logic := "U"; Y : out std_logic) ;
end component;

component DDR_REG
port(D, CLK, CLR : in std_logic := "U"; QR, QF : out std_logic) ;
end component;

signal Y : std_logic ;
begin

INBUF_SSTL2_1_0O_inst : INBUF_SSTL2_I
port map(PAD => PAD, Y => Y);
DDR_REG_O_inst : DDR_REG

port map(D => Y, CLK => CLK, CLR => CLR, QR => QR, QF => QF);

end DEF_ARCH;
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1.

The AES key is securely stored on-chip in dedicated low power flash device flash memory and cannot be
read out. In the first step, the AES key is generated and programmed into the device (for example, at a
secure or trusted programming site). The Microsemi Designer software tool provides AES key generation
capability. After the key has been programmed into the device, the device will only correctly decrypt
programming files that have been encrypted with the same key. If the individual programming file content
is incorrect, a Message Authentication Control (MAC) mechanism inside the device will fail in
authenticating the programming file. In other words, when an encrypted programming file is being loaded
into a device that has a different programmed AES key, the MAC will prevent this incorrect data from
being loaded, preventing possible device damage. See Figure 12-3 on page 304 and Figure 12-4 on
page 306 for graphical representations of this process.

It is important to note that the user decides what level of protection will be implemented for the device.
When AES protection is desired, the FlashLock Pass Key must be set. The AES key is a content
protection mechanism, whereas the FlashLock Pass Key is a device protection mechanism. When the
AES key is programmed into the device, the device still needs the Pass Key to protect the FPGA and
FlashROM contents and the security settings, including the AES key. Using the FlashLock Pass Key
prevents modification of the design contents by means of simply programming the device with a different
AES key.

AES Decryption and MAC Authentication

Low power flash devices have a built-in 128-bit AES decryption core, which decrypts the encrypted
programming file and performs a MAC check that authenticates the file prior to programming.

MAC authenticates the entire programming data stream. After AES decryption, the MAC checks the data
to make sure it is valid programming data for the device. This can be done while the device is still
operating. If the MAC validates the file, the device will be erased and programmed. If the MAC fails to
validate, then the device will continue to operate uninterrupted.

This will ensure the following:
» Correct decryption of the encrypted programming file

* Prevention of erroneous or corrupted data being programmed during the programming file
transfer

« Correct bitstream passed to the device for decryption

IGLOO and ProASIC3
D
_ MAC
Designer " | Validation
Software
Decrypted
Programming Bitstream
File Generation *
with AES AES S o
Encryption AE
l Key Decryption Core FlashROM Core
A

D

Transmit Medium /

Public Network

Encrypted Bitstream

Figure 12-4 « Example Application Scenario Using AES in IGLOO and ProASIC3 Devices

National Institute of Standards and Technology, “ADVANCED ENCRYPTION STANDARD (AES) Questions and Answers,”
28 January 2002 (10 January 2005). See http://csrc.nist.gov/archive/aes/index1.html for more information.
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ISP Programming Header Information

The FlashPro4/3/3X programming cable connector can be connected with a 10-pin, 0.1"-pitch
programming header. The recommended programming headers are manufactured by AMP (103310-1)
and 3M (2510-6002UB). If you have limited board space, you can use a compact programming header
manufactured by Samtec (FTSH-105-01-L-D-K). Using this compact programming header, you are
required to order an additional header adapter manufactured by Microsemi SoC Products Group (FP3-
10PIN-ADAPTER-KIT).

Existing ProASICELYS family customers who are using the Samtec Small Programming Header
(FTSH-113-01-L-D-K) and are planning to migrate to IGLOO or ProASIC3 devices can also use
FP3-10PIN-ADAPTER-KIT.

Table 13-3 « Programming Header Ordering Codes

Manufacturer Part Number Description

AMP 103310-1 10-pin, 0.1"-pitch cable header (right-angle PCB mount
angle)

3M 2510-6002UB 10-pin, 0.1"-pitch cable header (straight PCB mount
angle)

Samtec FTSH-113-01-L-D-K Small programming header supported by FlashPro and
Silicon Sculptor

Samtec FTSH-105-01-L-D-K Compact programming header

Samtec FFSD-05-D-06.00-01-N [ 10-pin cable with 50 mil pitch sockets; included in FP3-
10PIN-ADAPTER-KIT.

Microsemi FP3-10PIN-ADAPTER-KIT | Transition adapter kit to allow FP3 to be connected to a
micro 10-pin header (50 mil pitch). Includes a 6 inch
Samtec FFSD-05-D-06.00-01-N cable in the kit. The
transition adapter board was previously offered as
FP3-26PIN-ADAPTER and includes a 26-pin adapter for
design transitions from ProASICPLYS pased boards to
ProASIC3 based boards.

TCK
DO
™s [
VPUMP
DI

O N W -

2| GND

4 | NC (FlashPro3/3X); Prog_Mode* (FlashPro4)
6 | VUTAG

8| TRST

10 GND

Note: *Prog_Mode on FlashPro4 is an output signal that goes High during device programming and
returns to Low when programming is complete. This signal can be used to drive a system to provide
a 1.5V programming signal to IGLOO nano, ProASIC3L, and RT ProASIC3 devices that can run
with 1.2V core voltage but require 1.5V for programming. IGLOO nano V2 devices can be
programmed at 1.2 V core voltage (when using FlashPro4 only), but IGLOO nano V5 devices are
programmed with a VCC core voltage of 1.5 V.

Figure 13-5 « Programming Header (top view)
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useless to the thief. To learn more about the low power flash devices’ security features, refer to the
"Security in Low Power Flash Devices" section on page 301.

ProASIC3

MAC
Validation

A
i Decrypted [Stream
Designer Software AES KEY ryp

S I B

Programming
Control

AES AES
Encryption Decryption

A

TCP/IP
Public Network

Encrypted Stream Encrypted Stream

Figure 15-5 « ProASIC3 Device Encryption Flow

Conclusion

The Fusion, IGLOO, and ProASIC3 FPGAs are ideal for applications that require field upgrades. The
single-chip devices save board space by eliminating the need for EEPROM. The built-in AES with MAC
enables transmission of programming data over any network without fear of design theft. Fusion, IGLOO,
and ProASIC3 FPGAs are IEEE 1532—compliant and support STAPL, making the target programming
software easy to implement.
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List of Changes

The following table lists critical changes that were made in each revision of the chapter.

Date Changes Page
September 2012 The "Security" section was modified to clarify that Microsemi does not support 354
read-back of FPGA core-programmed data (SAR 41235).
July 2010 This chapter is no longer published separately with its own part number and N/A
version but is now part of several FPGA fabric user’s guides.
vi4 IGLOO nano and ProASIC3 nano devices were added to Table 15-1 < Flash- 350
(December 2008) Based FPGAs.
v1.3 The "Microprocessor Programming Support in Flash Devices" section was 350
(October 2008) revised to include new families and make the information more concise.
v1.2 The following changes were made to the family descriptions in Table 15-1 350
(June 2008) Flash-Based FPGAs:
* ProASIC3L was updated to include 1.5 V.
* The number of PLLs for ProASIC3E was changed from five to six.
v1.1 The "Microprocessor Programming Support in Flash Devices" section was 350
(March 2008) updated to include information on the IGLOO PLUS family. The "IGLOO
Terminology" section and "ProASIC3 Terminology" section are new.
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Flash Devices Support Power-Up Behavior
The flash FPGAs listed in Table 18-1 support power-up behavior and the functions described in this

document.

Table 18-1 « Flash-Based FPGAs

Series Family” Description

IGLOO IGLOO Ultra-low power 1.2 V to 1.5 V FPGAs with Flash*Freeze technology
IGLOOe Higher density IGLOO FPGAs with six PLLs and additional I/O standards
IGLOO nano The industry’s lowest-power, smallest-size solution
IGLOO PLUS IGLOO FPGAs with enhanced I/O capabilities

ProASIC3 ProASIC3 Low power, high-performance 1.5V FPGAs
ProASIC3E Higher density ProASIC3 FPGAs with six PLLs and additional I/O standards
ProASIC3 nano Lowest-cost solution with enhanced 1/O capabilities
ProASIC3L ProASIC3 FPGAs supporting 1.2 V to 1.5 V with Flash*Freeze technology
RT ProASIC3 Radiation-tolerant RT3PE600L and RT3PE3000L
Military ProASIC3/EL | Military temperature A3BPE600OL, A3P1000, and A3PE3000L
Automotive ProASIC3 | ProASIC3 FPGAs qualified for automotive applications

Note: *The device names link to the appropriate datasheet, including product brief, DC and switching characteristics,

and packaging information.

IGLOO Terminology

In documentation, the terms IGLOO series and IGLOO devices refer to all of the IGLOO devices as listed
in Table 18-1. Where the information applies to only one product line or limited devices, these exclusions

will be explicitly stated.

ProASIC3 Terminology

In documentation, the terms ProASIC3 series and ProASIC3 devices refer to all of the ProASIC3 devices
as listed in Table 18-1. Where the information applies to only one product line or limited devices, these
exclusions will be explicitly stated.

To further understand the differences between the IGLOO and ProASIC3 devices, refer to the Industry’s
Lowest Power FPGAs Portfolio.
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http://www.microsemi.com/soc/documents/RTPA3_DS.pdf

